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Notices

Trademarks

AJA® and Because it matters.® are registered trademarks of AJA Video Systems, Inc.
for use with most AJA products. AJA™is a trademark of AJA Video Systems, Inc. for
use with recorder, router, software and camera products. Because it matters.™ is a
trademark of AJA Video Systems, Inc. for use with camera products.

Corvid Ultra®, 10, Ki Pro®, KONA®, KUMO®, ROI® and T-Tap® are registered trademarks of
AJA Video Systems, Inc.

AJA Control Room™, KiStor™, Science of the Beautiful™, TruScale™, V2Analog™ and
V2Digital™ are trademarks of AJA Video Systems, Inc.

All other trademarks are the property of their respective owners.

Copyright

Copyright © 2020 AJA Video Systems, Inc. All rights reserved. All information in

this manual is subject to change without notice. No part of the document may be
reproduced or transmitted in any form, or by any means, electronic or mechanical,
including photocopying or recording, without the express written permission of AJA
Video Systems, Inc.

Contacting AJA Support

When calling for support, have all information at hand prior to calling. To contact AJA
for sales or support, use any of the following methods:

Telephone +1.530.271.3190

FAX +1.530.271.3140
Web https:/www.aja.com
Support Email support@aja.com
Sales Email sales@aja.com
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Chapter 1 - Introduction

Overview
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AJA 10 GigE IP Mini-Converters are designed for point of use applications for
encoding, transport, reception and decoding of IP based video sources. Rugged,
compact and fanless, the 10 GigE IP Mini-Converters provide the bridge between
Baseband and IP video for a range of applications, such as sending and receiving
video over IP from remote facilities in post production, source monitoring, digital
sighage, and video walls. 10 GigE IP Mini-Converters ease the cost of extensive
monitoring distribution in a facility.

The 10 GigE IP Mini-Converter Transmitters take baseband HDMI or SDI input
and encode the data as SMPTE 2110. The embedded audio associated with the
video stream is also encoded to SMPTE 2110. Alternatively, analog audio can be
encoded and sent with the video stream instead.

The 10 GigE IP Mini-Converter Receivers decode SMPTE 2110 and format the data
for either HDMI or SDI output. The audio associated with the video stream is
extracted, synchronized, and then embedded into the HDMI or SDI signal as well
as output on a stereo analog RCA audio output.

All UltraHD rates (23.98, 24, 25, 29.97, 30, 50) can be received only by the IPR-10G2-
HDMI.

The IPR-10G2-HDMI can provide RGB (rather than YCbCr) to a compatible monitor
if the monitor or other sink device indicates this availability via EDID.
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Pre-Built System Configuration Modes for IPR-10G2

There is a set of pre-built system configuration modes, or "system modes,"
available from the System Mode control on the Config page of the IPR-10G2 web
Ul. These pre-built System Modes are designed to save you time so that you can
get your unit up and running quickly.

Each System Mode is built for a specific type of use case, taking into account
factors such as network conditions, protection requirements, timing, and latency
considerations.

Please see "System Modes" on page 41 for more detailed information.

NOTE: The System Modes are available only for the IPR-10G2-SDI and IPR-10G2-HDMI
units; they are not needed on the IPT-10G2-SDI and IPT-10G2-HDM!| units since the
transmitter's functionality is simpler.

On a high level, the five pre-built System Modes are described as follows:

PTP Low Latency
« Appropriate under ideal network conditions

« Fastest method of moving data through the device (does not require signal
processing)

« Provides the least amount of packet-level and frame-level protection
« Remote sender and AJA IPR-10G2 receiver are locked to PTP
PTP Protected

« Provides the highest amount of packet-level and frame-level protection,
including redundancy support with ST 2022-7

« Maximum latency due to longer signal processing chain

+ Remote sender and AJA IPR-10G2 receiver are locked to PTP
Gateway

« Bridges between PTP and Reference Video timed domains

« Provides frame-level protection

+ Moderate latency due to signal processing chain
Gateway Protected

« Bridges between PTP and Reference Video timed domains

+ Provides the highest amount of packet-level and frame-level protection,
including redundancy support with ST 2022-7

+ Maximum latency due to longer signal processing chain
Asynchronous

« Intended as a setup environment or troubleshooting and demo tool

« Not for production

+ When unable to lock to PTP or when experiencing problems with Reference
In, uses Video In to verify that video is being received from source address

- Provides frame-level protection (no packet-level protection)
« Moderate latency due to signal processing chain

10 GigE IP Mini-Converters SMPTE 2110 IP Transmit/Receive v2.3r1 6 www.aja.com



Advanced

Unlike the five pre-built System Modes just described, each of which are "safe,"
Advanced Mode does not guard against a user applying contradictory settings
that could provide unpredictable results.
Characteristics of Advanced Mode include the following:

+ For custom configurations

« Has no native default settings

« Can be used to iterate and expand upon the five pre-built System Modes
described above

+ Provides free-range access to:
+ Video Clock Mode
+ Packet Protection Mode
+ Frame Sync Mode
+ System Mode
+ Audio Sample Rate Converter

+ When selected, Advanced Mode will retain the settings of the previously
selected System Mode, and the user may proceed to customize settings as
desired. This means that any of the System Modes can be modified using
Advanced Mode and then saved as a Preset on the Presets screen.

NOTE: When working with Advanced Mode, if the configuration settings become
problematic, you can always "revert" to one of the five pre-built System Modes to
get the unit running again with established internally compatible settings.

10 Gigk IP Mini-Converters Features

IPT-10G2-SDI

SMPTE ST 2110 audio, video transmitter including support for ST 2022-7
+ Essence support: SMPTE 2110-10, 2110-20, 2110-30
+ Rugged, quiet, fanless design

+ 2x 10 GigE SFP+ cages for media LAN with status light (for media transport,
control, and timing input), SFP+ modules not included)

+ 1x 1 GigE RJ45 socket for control LAN with status light
« Complete control interface on any web browser from a built-in web server
+ Customizable control with AJA REST API

« Control supported over dedicated management Ethernet port and in-band
over media ports

« NMOS Rx discovery and control according to standards 1S-04 v1.3 and IS-05
v1.1

+ Ember+ control (no discovery, control only)
+ AJA REST API control (discovery via SSDP or MDNS)
+ LLDP (Link Layer Discovery Protocol)

+ 1x 3G-SDI Input

» 1x3G-SDI Loop Out

« Support for HD up to 1080 60p, YCbCr 4:2:2

- Concealment of errors due to packet loss

« Full 10-bit pixel processing pipeline

« Embedded SDI audio input (up to eight channels)

« 2x RCA analog audio input

10 GigE IP Mini-Converters SMPTE 2110 IP Transmit/Receive v2.3r1 7
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+ 1x BNC Reference Out, allowing incoming baseband sources to be locked to
PTP timing

+ Frame Sync

« 1x mini-USB port for initial network configuration with AJA eMini-Setup
software (alternative setup method)

« 5-year international warranty and support

IPT-10G2-HDMI

SMPTE ST 2110 audio, video transmitter including support for ST 2022-7
+ Essence support: SMPTE 2110-10, 2110-20, 2110-30
» Rugged, quiet, fanless design

+ 2x 10 GigE SFP+ cages for media LAN with status light (for media transport,
control, and timing input), SFP+ modules not included)

+ 1x 1 GigE RJ45 socket for control LAN with status light
« Complete control interface on any web browser from a built-in web server
+ Customizable control with AJA REST API

« Control supported over dedicated management Ethernet port and in-band
over media ports

« NMOS Rx discovery and control according to standards 1S-04 v1.3 and IS-05
V1.1

+ Ember+ control (no discovery, control only)
+ AJA REST API control (discovery via SSDP or MDNS)
+ LLDP (Link Layer Discovery Protocol)

+ Dedicated HDMI transmitter with full size (standard type A) HDMI 1.4b (24/30-
bits per pixel) input up to HD 60p, 4:2:2, 10-bit, YCbCr

- Concealment of errors due to packet loss

« Full 10-bit pixel processing pipeline

« Embedded SDI audio input (up to eight channels)
« 2x RCA analog audio input

+ 1x BNC Reference Out, allowing incoming baseband sources to be locked to
PTP timing

+ Frame Sync

« 1x mini-USB port for initial network configuration with AJA eMini-Setup
software (alternative setup method)

« 5-year international warranty and support

IPR-10G2-SD

« SMPTE ST 2110 audio, video receiver including support for ST 2022-7
+ Essence support: SMPTE 2110-10, 2110-20, 2110-30
+ Rugged, quiet, fanless design

+ 2x 10 GigE SFP+ cages for media LAN with status light (for media transport,
control, and timing input), SFP+ modules not included)

+ 1x 1 GigE RJ45 socket for control LAN with status light
« Complete control interface on any web browser from a built-in web server
+ Customizable control with AJA REST API

« Control supported over dedicated management Ethernet port and in-band
over media ports

« NMOS Rx discovery and control according to standards 1S-04 v1.3 and IS-05
v1.1

+ Ember+ control (no discovery, control only)
+ AJA REST API control (discovery via SSDP or MDNS)

10 GigE IP Mini-Converters SMPTE 2110 IP Transmit/Receive v2.3r1 8 www.aja.com



+ USB Keyboard Control for Recalling Presets

« 2x3G-SDI Output (mirrored)

« Support for HD up to 1080 60p, YCbCr 4:2:2

- Concealment of errors due to packet loss

« Full 10-bit pixel processing pipeline

« Embedded SDI audio output (up to eight channels)
+ 2x RCA analog audio output

« 1x BNC Reference for analog/tri-level reference input, allowing baseband
output to be locked to the facility baseband clock (instead of PTP)

+ 1x mini-USB port for initial network configuration with AJA eMini-Setup
software (alternative setup method)

- 5-year international warranty and support

IPR-10G2-HDMI

« SMPTE ST 2110 audio, video receiver including support for ST 2022-7
« Essence support: SMPTE 2110-10, 2110-20, 2110-30
» Rugged, quiet, fanless design

+ 2x 10 GigE SFP+ cages for media LAN with status light (for media transport,
control, and timing input), SFP+ modules not included)

« 1x 1 GigE RJ45 socket for control LAN with status light
« Complete control interface on any web browser from a built-in web server
+ Customizable control with AJA REST API

«+ Control supported over dedicated management Ethernet port and in-band
over media ports

« NMOS Rx discovery and control according to standards IS-04 v1.3 and IS-05
V1.1

+ Ember+ control (no discovery, control only)
+ AJAREST API control (discovery via SSDP or MDNS)
« USB Keyboard Control for Recalling Presets

- Dedicated HDMI receiver with full size (standard type A) HDMI 1.4b (24/30-bits
per pixel) output up to HD 60p, 4:2:2, 10-bit, YCbCr/RGB, or UltraHD 30p,4:2:2,
10-bit, YCbCr, or UltraHD 50p, 4:2:0, 8-bit, YCbCr

« ST 2022-7 is supported up to HD 1080p (UltraHD not supported)

« Concealment of errors due to packet loss (error concealment functionality
supported up to 1080p 60, UltraHD not supported)

- Full 10-bit pixel processing pipeline (except for UHD p50)
+ Embedded HDMI audio output (up to eight channels)
« 2x RCA analog audio output

« 1x BNC Reference for analog/tri-level reference input, allowing baseband
output to be locked to the facility baseband clock (instead of PTP)

+ 1x mini-USB port for initial network configuration with AJA eMini-Setup
software (alternative setup method)

« 5-year international warranty and support
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Abbreviated Feature Comparison Chart for v2.3

Model UltraHD | Reference | System 2022-7 RGB 4:4:4
Support | Functions | Modes support | 10-bit
IPT-10G2-SDI Ref Out Up to
1080 p60
IPT-10G2-HDMI Ref Out Up to
1080 p60
IPR-10G2-SDI Ref In Supported | Up to
1080 p60
IPR-10G2-HDMI | Up to Ref In Supported | Up to Up to
UHD p50 1080 p60 | 1080 p60

Workflow Diagrams and I/O Connections

Figure 1. Example Workflow Diagram for the IPT-10G2-SDI
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Figure 2. IPT-10G2-SDI Connections
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Figure 4. IPT-10G2-HDMI Connections
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Figure 5. Example Workflow Diagram for the IPR-10G2-SD/

Recorder/Player
or other SDI destination

N®

O

[ JDD( ) [
o0o( J
00000000 - MG e

me
J
~1n0 ]

—— b

1x SDI

3G-SDI

—
Black Burst/
Tri-level sync 1x SDI
generator 36Dl
3

HD SDI Monitor

Analog/Tri-Level
Reference Input BNC

— =

-
Aubio

<=

< soioutt

@ o

IPR-10G2-SDI
1P TO SDI

2 Channel
Unbalanced
Analog Audio
Output
(RCA Jacks)

Output SDI
Connector 1

Output SDI

Connector 2

USB Port

+5-16 VDC
Power Input

CONTROL LaN

READY

Lock.

LINK/ACT 1

MEDIALAN 1

MEDIALANZ

LINK/ACT2

<.

AUDIO

« R

< soiout1

<« soiour2

B> RreFiN

Media Server

IDM )©

=
=

L[ (

‘ )
il

10 GigE
Input/Output

10 GigE Switch

PTP Generator

000|000 el
Q0000 & [©]

|

]

[ \ ]

HD (up to 60p)

Redundant
IP feeds

CONTROL LAN

LOCK

LINK /ACT 1

MEDIA LAN 1

IPR-10G2-SDI

IP TO SDI

MEDIA LAN 2

LINK / ACT 2

-~

Control
LAN

Ready LED

Lock LED

Link/Act
LED 1

SFP+ Cage for
10 Gbps Ethernet

SFP+ Cage for
10 Gbps Ethernet

Link/Act
LED 2

10 GigE IP Mini-Converters SMPTE 2110 IP Transmit/Receive v2.3r1 12

www.aja.com



Figure 7. Example Workflow Diagram for the IPR-10G2-HDMI
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Simplified Block Diagrams and Logic Diagrams

Figure 9. IPT-10G2-SDI/HDMI Simplified Block Diagram

IPT-10G2-SDI / IPT-10G2-HDMI

'SR

Reference _
Output @‘

Control LAN : >
Video over IP

HDMI Input Processing
with Embedded
(IPT-10G2-HDMI only)

Audio

Video

Y

—) Media LAN 1
Video over IP
Transmitter

—) Media LAN 2

Audio

sDIInput ()

SDI Loop Through @ <

Y

(IPT-10G2-SDI only) I

TA A
2-Channel

RCA Analog c
Audio Input

USB Port

(connect to PC or Mac) m‘
For initial setup of
network interfaces

Figure 10. IPR-10G2-SDI/HDMI Simplified Block Diagram
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Figure 11. IPR-10G2-SDI/HDMI Simplified Logic Diagram
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Frequently Asked Questions

To access responses to fregently asked questions about the
10 GigE IP Mini-Converters, please use the following links:

« https://www.aja.com/products/ipt-10g2-sdi#support

« https://www.aja.com/products/ipt-10g2-hdmi#support

« https://www.aja.com/products/ipr-10g2-sdi#support

« https://www.aja.com/products/ipr-10g2-hdmi#support

System Requirements

Remote computer configuration and control is accomplished using the

10 GigE IP Mini-Converters' internal web server. A macOS X or Windows
computer with a web browser installed is all that is required. Additionally, initial
configuration using eMini-Setup will require a USB port between the host
computer and the 10 GigE IP Mini-Converter.

NOTE: Chrome and Firefox are the preferred web browsers for control on Windows.
Safari is the preferred web browser for control on macQOS. Other web browsers
may work, but AJA cannot guarantee consistent operation for all web browsers or
web browser versions.

Control LAN, Ready, Link/Act, and Lock LED Behavior

The Control LAN LED illuminates to indicate a link. Blinking indicates activity.

The Ready LED illuminates green when the unit has finished powering up and is
ready to use.
The Link/Act LED 1 and Link/Act LED 2 behavior is as follows:
- Off - No SFP+ module present
+ Red - SFP+ module present, no link
« Green - Linkis up
« Green flash - Link is up and there is Tx or Rx activity
The Lock LED behavior is as follows:
«+ Off - No Precision Time Protocol (PTP) is detected
+ Red - APTP error is detected
« Yellow and flashing - Locking Phase 1
+ Yellow - Locking Phase 2
«+ Green and flashing - Locking Phase 3
+ Green - Signal is locked

NOTE: Achieving locked status may take 5 or more minutes depending on network jitter
behavior. The output of the unit will still function during the locking period.

Installation Overview

Detailed instructions are provided in "Chapter 2 — eMini-Setup" on page 18 and
"Chapter 3 — 10 GigE IP Mini-Converters Web Interface" on page 27.

As an overview, however, there are two methods available for initial setup for
10 GigE IP Mini-Converters:

1. Using a web browser on the host computer connected to the same network
as the 10 GigE IP Mini-Converter, or
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2. Using the AJA eMini-Setup application running on the host computer that is
directly connected to the 10 GigE IP Mini-Converter via USB.

Initial Setup By Web Browser

NOTE: Chrome and Firefox are the preferred web browsers for control on Windows.
Safari is the preferred web browser for control on macQOS. Other web browsers
may work, but AJA cannot guarantee consistent operation for all web browsers or
web browser versions.

10 GigE IP Mini-Converters require a network connection for initial configuration,
control and firmware updates. 10 GigE IP Mini-Converters are shipped from the
factory with DHCP enabled, and support automatic network discovery via SSDP
and MDNS.

To Set Up the Unit with a Web Browser

1. Connect the 10 GigE IP Mini-Converter Control Port to the intended
network with an Ethernet cable.

2. Theintended network’s DHCP Server will assign an IP address and the 10
GigE IP Mini-Converter will join that network.

3. Locate and connect to the AJA 10 GigE IP Mini-Converter.

Windows PC Host
A. Open Windows Explorer.
B. Navigate to the Network.
C. Click on the Network to enumerate network devices.
D. Search for either “IPT-10G2,” "IPR-10G2," or the device's Serial Number.
E. Double-click on the intended 10 GigE IP Mini-Converter. The host machine
web browser will launch and display the web Ul for the device.
macOS Host

A. Go to System Preferences > Sharing and turn on File Sharing.

B. Open the Finder Window.

Navigate to Shared > All...

Click on All... to enumerate network devices.

Search for either “IPT-10G2,” "IPR-10G2," or the device’s Serial Number.

mmo N

Double-click on the intended 10 GigE IP Mini-Converter. The host machine
web browser will launch and display the web Ul for the device.

NOTE: Ifthe above does not work, then you will need to download and install an MDNS
browser to assist with discovering network devices on a macOS host.

Initial Setup By AJA eMini-Setup

1. Acquire AJA eMini-Setup (version 2.1) from the AJA website for either
macOS or Windows:

https:/www.aja.com/family/software#eminisetup

2. Install eMini-Setup:
A. Unzip the Installer.
B. Run the .dmg file on macOS or the .msi file on Windows.

3. Connect Power to your AJA Ethernet equipped Converter.
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4. Connect the USB config cable to the computer running eMini-Setup.
5. Open eMini-Setup and configure the device’s network settings.

NOTE: DHCP is enabled by default, and if the device is connected to a DHCP server the IP
address field will populate.

6. Enter the IP address into a browser window. The web Ul for your AJA device
will display.

7. Use the web Ul to fully configure and control your AJA Device.

Hardware Installation

Temperature of Unit

The 10 GigE IP Mini-Converters pack an unprecedented feature set into the mini
converter box. As a result, the unit uses approximately 13 watts of power. It will be
very warm to the touch, which is normal. The unit is engineered to operate across
the full temperature range, from 0 to 40 degrees C.

Access to Air for Proper Cooling

For highest reliability, the mini converters rely on convection cooling instead
of using a built-in fan. Therefore, when installing the units, mountin a
location where they have access to air for proper cooling. Do not stack the
10 GigE IP Mini-Converters with other mini converters or other powered
equipment.

Number of LAN Connections

Three LAN connections to the unit are not necessarily required on an ongoing
basis. If it is desirable for your installation, after the 10 GigE IP Mini-Converter is
set up, you can access all control parameters through one of the Media LANs with
the appropriate network configuration. See "Networking Option — Using Only the
Media LAN Port for Control and Media Settings" on page 27 for more information.

Settings Retained

The current 10 GigE IP Mini-Converter's configuration settings are retained even
when powered off, so subsequent installations for an identical decoding or
encoding session can be done with the following simple steps:

1. Apply power to the 10 GigE IP Mini-Converter.

2. Connect the unit to your network using the Control LAN, Media LAN 1 and
Media LAN 2 and connect the unit’s inputs and outputs.

REST APl Documentation

AJA’s REST automation API provides a platform from which you can issue
commands to an AJA device’s internal web server, allowing remote systems

the ability to control AJA embedded or networked devices. With this control
framework, you can build integration and automation scripts, using any scripting
language, allowing you to take full advantage of the device’s functionality.

This documentation is available at the following link:

https://gitlab.aja.com/pub/rest api
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Chapter 2 — eMini-Setup

Overview

This chapter describes using the eMini-Setup application to initially communicate
with and configure a 10 GigE IP Mini-Converter over a direct USB connection.
Once configured, the IP Mini-Converter can be accessed via an Ethernet network
using a web browser. Subsequently, that device can then be reconfigured over
that network, using its IP address and built-in web server.

NOTE: The eMini-Setup application is only used to setup selected Ethernet capable AJA
devices, and cannot be used to connect to or setup other AJA Mini-Converters.

The general procedure is:

1. Acquire eMini-Setup from the AJA website and install the eMini-Setup
application onto a computer.

2. Connect the IP Mini-Converter to that computer’s USB port.
3. Launch the eMini-Setup application.

4. Go to the Control Network tab and Media Network tabs, where the IP
address settings are displayed. You can use the existing DHCP assigned IP
address, or it can be changed manually.

5. You can also use eMini-Setup to load firmware to the device, although this
can also be done quickly and easily using the web browser interface.

Acquiring eMini-Setup

AJA's eMini-Setup application is available for download from the AJA website.

To download the latest eMini-Setup package, which includes the eMini-Setup
application and documentation:

1. Goto:

https://www.aja.com/family/software#eminisetup

2. Click the link corresponding to the version you want to download for Mac or
Windows.

NOTE: IPT-10G2-SDI and IPT-10G2-HDMI require eMini-Setup version 2.1 or later.
IPR-10G2-SDI and IPR-10G2-HDMI require eMini-Setup version 2.0 or later.

eMini-Setup Documentation

Included with the eMini-Setup download is the AJA device's Installation and
Operation Guide, which can be accessed from the eMini-Setup Ul via the Help/
Manual drop-down menu. This manual includes eMini-Setup information.

Documentation can also be accessed directly from the Mac eMini-Setup installer
in the Documentation folder.

Documentation included with the eMini-Setup application is the version available
at the time of distribution. However, AJA’s documentation can be updated
regularly, so newer versions may exist.
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To download just the latest documentation, go to:

https://www.aja.com/family/ip-converters
Click the support button and open the Manuals link.

Installing eMini-Setup

PC Installation

To install eMini-Setup on a Windows PC:

1. Download the application from the AJA website. See "Acquiring eMini-Setup"
on page 18.

2. Open the AJA_eMini-Setup_win.zip file.
3. Double-click on the AJA_eMini-Setup.msi file.

4. The Setup Wizard will guide you through the installation.
Figure 12. eMini-Setup PC Wizard

(551 AJA eMini-Setup

A A Welcome to the AJA eMini-Setup
J Setup Wizard

VIDEQ SYSTEMS

The Setup Wizard will install AJA eMini-Setup on your
computer. Click Next to continue or Cancel to exit the Setup
Wizard.

5. Click Next to begin. Answer the questions in the subsequent dialogues,
including device software installation if displayed. When finished, an AJA
eMini-Setup shortcut will be installed on the desktop, and you will be able
to locate the eMini-Setup application in the AJA folder in the Programs
listing.

NOTE: Ifthe eMini-Setup application already exists on the PC, a different Setup Wizard
appears.
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Figure 13. eMini-Setup Wizard, Re-installation
15 AA eMini-Setup. (S

Change, repair, or remove installation
Select the operation you wish to perform, &

Change

AJA eMini-Setup has no independently selectable features.

Repairs errors in the most recent installation by fixing missing and corrupt
files, shortcuts, and registry entries.

Remove

Removes AJA eMini-Setup from your computer.

With this screen you can Repair (reinstall) or Remove (uninstall) eMini-Setup on
the PC.

Mac Installation

To install the application on a Mac:

NOTE: Mac computers must be Intel-based (G5, G4 and earlier models will not work with
eMini-Setup).

1. Download the application from the AJA website. See "Acquiring eMini-Setup"
onpage 18.

2. Unzip thefile.
3. Double-click on the AJA eMini-Setup.dmg file.
4. Answer the prompt and a utility program will be launched.

Figure 14. eMini-Setup Mac Installer

®0® .| AJA eMini-Setup

AJA eMini-Setup

AJA eMini-Setup Docs

VIDEQ SYSTEMS. ”
Applications
Because it matters.

5. To complete the installation drag the “AJA eMini-Setup” icon to the
Applications folder.

Running eMini-Setup

Connect your Ethernet capable AJA device to the PC or Mac via the supplied USB
cable, and then connect the external power supply (supplied) to that AJA device.
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PC Startup

To run eMini-Setup on a PC, double-click on the AJA eMini-Setup icon on your
desktop, or open the AJA folder in the program list and click on the AJA eMini-
Setup application located inside the eMini-Setup folder.

Figure 15. Launching eMini-Setup on a PC

; Al Computer
AJA ControlPanel
& AJA ControlRoom Control Panel
B AJA Multi-Channel Config
. AJA Systemn Test

J Documentation

Devices and Printers

Default Programs

. eMini-Setup
£ aa eMini Setup Help and Support
. Documentation
. Mini Connect
4 Back
| |Search programs and files Shut down r>_1

Mac Startup

To run eMini-Setup on a Mac, open the Applications folder and locate the AJA
eMini-Setup application. Double-click the application to launch it.

Operating eMini-Setup
The eMini-Setup application provides a graphical user interface for viewing

settings, modifying settings, and updating software.

Figure 16. Example eMini-Setup Screen

File Edit Help

| IPR-10G2-HDMI-ENG004 - 1HEDD0000 - |

Select an
~— attached
AJA device

Control Connected
LAN —

USB < HDMI — LAN .
connection —_| connection

#=n! \ Refin status
<tatus \ S\ = | Connected —
Connected USB IPR-1062-|‘|DM| H /

1P TO HOMI M

Power

Status | Connected
Tabbed
— .
screens > Version: 2.2.0.34d Sn: THEDDODOOO
Control LAN H Media LAN 1 | MedialAN2 | Update | Info |
IP Address Type: | Static - | Static UPRP Host: | Enable = | Enabled
IP Address: |10.3.37.111 10.3.37.111 ’v‘*‘\C*\ddfeSE|00.0A.3500.1E.53
Subnet Mask: [255 255 0.0 255.255.0.0
Gateway: 10303 10.3.0.3
| Apply | | OpenwebPage |

Connected to module

Selecting an AJA device from the pull down menu on the upper right causes
eMini-Setup to connect to the selected AJA device.
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Version - The version of firmware installed in the AJA device is displayed below
the graphic.

Sn - This is the factory set unique serial number of your AJA device. If you ever call
AJA Support for service, you may be asked for this number.

A status field at the bottom of the screen shows if the eMini-Setup application is
connected and communicating with an AJA device.

File Menu - The File drop-down menu on the eMini-Setup application bar has a
Revert to Factory Settings menu item that allows you to change the settings
back to the AJA device’s factory defaults.

Edit Menu - The Edit drop-down menu has standard Cut, Copy and Paste
functions for editing text.

Help Menu - The Help drop-down menu has a link to the AJA device’s manual.

Control LAN Tab Screen

Figure 17. eMini-Setup Control LAN Tab Screen

File Edit Help

IPR-10G2-HDMI-ENGO04 - 1HEDDOOOO -

SULE Connected
LAN

%
| / N
:!i » Refin @

bl USE  |PR-10G2-HDMI
Power 1P TO HOMI 3
Status | Connected

| Connected

Version: 2.2.0.34d Sn: THE0Q0000

Control LAN Media LAN 1 Media LAN 2 Update Infa

IP Address Type: | Static - | Static UPnP Host: | Enable ~ | Enabled
IP Address: |10.3.37.111 10.3.37.111 MAC Address: | go:0A:35:00:1E:53
Subnet Mask: | 255 255.0.0 25525500
Gateway: [10.2.0.2 10.3.0.3
Apply Open Web Page

Connected to module

Use this Control LAN tab to change the network setup on the connected AJA
device. You must click the Apply button to initiate any network configuration
changes.

IP Address Type - Choose from DHCP (default) or Static IP Address.

NOTE: A basic setup would be to run an Ethernet cable directly between the device and
your laptop and set both the computer and IPR to sequential static IP addresses.
This provides a rapid way to set up to access the web user interface.

IP Address - The current IP Address is displayed. A different IP address can be
entered.

Subnet Mask - The current Subnet Mask is displayed. A different subnet mask
can be entered.

Gateway - The current Gateway address is displayed. A different gateway address
can be entered.
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UPnP Host - Choose from Enable or Disable to control whether the AJA device
makes itself visible for Windows network browsing.

MAC Address - This is the permanent MAC address of the Control LAN Ethernet
port of the AJA device.

Open Web Page - Opens the IP Mini-Converter's web interface in a web browser.

Media LAN 1 Tab Screen

Figure 18. eMini-Setup Media LAN 1 Tab Screen

File Edit Help

| IPR-10G2-HDMI-ENGO04 - 1HEQDDOO0 -

SR Connected
LAN

N
:lj » Refin

REiE 'S |PR-10G2-HDMI
Power 1P TO HOMI E
Status | Connected

| Connected

Version: 2.2.0.34d Sn: THE0Q0000

Control LAN | MediaLAN 1 | MediaLAN2 | Update | Info |

IP Address Type: | Static - | Static

IP Address: 172.16.37.111 172.16.37.111 MAC Address: | gg-pa-35:00-1E'55
SubnetMask: | 255 255.0.0 25525500

| Apply | | OpenwebPage |

Connected to module

Use this Media LAN 1 tab to change the corresponding media network setup
on the connected AJA device. You must click the Apply button to initiate any
network configuration changes.

IP Address Type - Choose from DHCP or Static IP Address.

NOTE: Ifyou intend to directly connect an IPT to an IPR, then you will need to use

sequential static IP addresses for both units (Transmit and Receive).
IP Address - The current IP Address is displayed. A different IP address can be
entered.

Subnet Mask - The current Subnet Mask is displayed. A different subnet mask
can be entered.

Gateway - The current Gateway address is displayed. A different gateway address
can be entered. On the Media LAN, the gateway may be left blank. (A gateway
is required on the Control LAN).

MAC Address - This is the permanent MAC address of the Media LAN Ethernet
port of the AJA device.

Open Web Page - Opens the IP Mini-Converter's web interface in a web browser.
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Media LAN 2 Tab Screen

Figure 19. eMini-Setup Media LAN 2 Tab Screen

File Edit Help

| IPR-10G2-HDMI-ENGO04 - 1HEQDDOO0 -

Control Connected
LAN

| Connected
Connected [lik3:3 IPR-10G2-HDMI
Power 1P TO HOMI 3
Status | Connected
Version: 2.2.0.34d Sn: THE0Q0000
Control LAN || MediaLAN1 | MedialAN2 | Update | info |
IP Address Type: | Static - | Static
IP Address: 172.16.137.111 MAC Address: [g0-0A35:00:1E-56
Subnet Mask: | 255 255.0.0 25525500
| Apeply | | OpenwebPage |

Connected to module

Use this Media LAN 2 tab to change the corresponding media network setup
on the connected AJA device. You must click the Apply button to initiate any
network configuration changes.

IP Address Type - Choose from DHCP or Static IP Address.

NOTE: Ifyou intend to directly connect an IPT to an IPR, then you will need to use

sequential static IP addresses for both units (Transmit and Receive).
IP Address - The current IP Address is displayed. A different IP address can be
entered.

Subnet Mask - The current Subnet Mask is displayed. A different subnet mask
can be entered.

Gateway - The current Gateway address is displayed. A different gateway address
can be entered. On the Media LAN, the gateway may be left blank. (A gateway
is required on the Control LAN).

MAC Address - This is the permanent MAC address of the Media LAN Ethernet
port of the AJA device.

Open Web Page - Opens the IP Mini-Converter's web interface in a web browser.
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Update Tab Screen

Figure 20. eMini-Setup Update Tab Screen

File Edit Help

| IPR-10G2-HDMI-ENGD04 - 1HE000000

Control Connected
LAN
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S > Refin

| | Connected
il US®  1PR-10G2-HDMI
Power 1P TO HOMI E
Status ! Connected
Version: 2.2.0.34d Sn: THE0QQ0O0
Control LAN | MedialLAN1 | MediaLAN2 | Update | Info |
Installed: 2.2.0.34d | Browse.

Progress: 0%

For latest firmware: AJAIPR-10G2-HDMI

Connected to module

Use this Update tab to install new firmware.
Installed - This field shows the version of the firmware currently installed.

Browse - This button opens a navigation window, allowing you to select the

firmware and load that version of firmware into the AJA device’s non-volatile

memory.

Progress - This indicator bar shows the progress of firmware installation.

Firmware Update Procedure

1. Check the AJA website for new firmware.

2. If new software is found, download it and uncompress the file archive (.zip).
3. Connect the device to a Mac or PC via a USB port on the computer.
4

. Click the Update tab. Click the Browse button. Navigate to the firmware

(.ajas extension), open it, and confirm the update. Progress will be shown via

the “Progress” bar.

5. After the update, the AJA device must be rebooted by clicking on the
Reboot button in the prompt window.

See also: "Firmware Screen" on page 54 regarding the process of working with
firmware with the IP Mini-Converter's Web Ul.
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Info Tab Screen

Figure 21. eMini-Setup Info Tab Screen
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System Name: [IPR-10GZ-HDMI-ENG004 | [ SetSystem Name

Type: IPR-10G2-HDMI

Authentication: Disabled Disable

Connected to module

This tab provides basic information about the connected AJA device. This
information is mostly useful when calling AJA Support for service or technical
support.

System Name - This field allows you to give your AJA device a unique name. This
can be useful if you have several attached to a Mac/PC via USB so you can
distinguish between them easily.

Type - This is the factory set model name of the AJA device.

Authentication - If Authentication has been Enabled on the web browser Access
tab, you can disable the security feature by clicking the Disable button.
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Chapter 3 — 10 GigE IP Mini-Converters Web

Interface

Overview

Once you have established network connectivity with the 10 GigE IP Mini-
Converter, you can further configure and more fully control the unit through its
web interface. Subsequently, eMini-Setup is no longer required to interface with
the unit.

NOTE: Itis often best to remove the USB connection once you have acquired the web
interface. This prevents accidentally using eMini-Setup to change parameters
already set via the web Ul

Remote Control Overview

An optimized web server in the 10 GigE IP Mini-Converter allows remote
control and parameter setting adjustments via a browser client runningon a
network wired computer. The network can be a closed local area network, a
direct connection between a 10 GigE IP Mini-Converter and a computer, or even
exposed through a firewall to a WAN.

Each 10 GigE IP Mini-Converter uses a standard RJ-45 connector for the Control
LAN connection, and two SFP+ cages for the 10 Gbps Ethernet Media LAN
connections.

NOTE: Sdfariis the preferred web browser for control on the Mac, and additionally
Chrome and Firefox on Windows. Other web browsers may work, but AJA cannot
guarantee consistent operation for all web browsers or web browser versions.

To connect to the 10 GigE IP Mini-Converter, attach the unit to your network and
enter its Control Network IP address into the web browser. If authentication has
been configured, you may need to enter a password.

Networking Option — Using Only the Media LAN Port for
Control and Media Settings

To reduce facility cabling to the 10 GigE IP Mini Converter, it is an option to setup
your network connection through an Ethernet switch via the Media LAN ports
(rather than using the dedicated Control Port). This means that you will have just
one or two cables to the unit, instead of two or three.

To implement this approach, follow these general steps:

1. Note the IP address of the unit’s Media LAN 1 or Media LAN 2 port. This
should be a static IP address.

2. Connect the controlling computer’s Ethernet port that is being used to
control the unit into an Ethernet switch. This requires disconnecting the
Ethernet cable from the Control LAN port of the unit.

3. Connect the Media LAN port of the unit into the Ethernet switch.
4, Connect the source of the Media IP stream into the Ethernet switch.

5. Set the controlling computer’s Ethernet port that is being used to control
the 10 GigE IP Mini-Converter to DHCP.
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6. From the controlling computer, point a web browser to the IP address noted
in step 1. The 10 GigE IP Mini-Converter’s web user interface displays in the
browser.

Web Browser via Ethernet

General Screen Information

All IP Mini-Converter web screens have certain areas and controls in common.
Vertical and horizontal scroll bars appear when information extends past the
border of a panel.

The round blue Up/Down arrow button on each panel and many status
parameters opens and closes that pane or set of parameters.

Menu Panel

On the left of each screen is a Menu panel listing all the available screens. Click
any of these links to jump to that screen.

Alarms Panel

Alarms are displayed in a panel on the left side of each screen. Clicking on the
arrow opens or closes this panel to show or hide the alarms. Hovering the mouse
over an alarm (red) or warning (yellow) may provide additional detail about the
condition.

Connections Panel

On the right side of every screen is a Connection panel listing information for the
connected IP Mini-Converter.

Network Panel

Also on the right is a Network pane that lists other IP Mini-Converters on the
network. The gear icon opens the Network Screen, the same as selecting Network
from the Menu Panel. Right-clicking on the name of an IP Mini-Converter in

this list allows you to turn on the Identify feature, which will blink all four of the
Ethernet LEDs of that device at a 1 second rate.

Parameters and Information

The rest of the screen displays all the parameter selections and information
available for the selected IP Mini-Converter screen.
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Figure 22. Overview of Web Browser User Interface
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+ From the Config Screen, right clicking on the parameter name resets just that

parameter to its factory default.

« For values with sliders, fine control is achieved using the arrow keys on the
keyboard to move the slider the minimum amount. The numeric value can

also be clicked on to enter a specific value.
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Status Screen

IPT-10G2-SDI

Figure 23. IPT-10G2-SDI Status Screen 1 of 2
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Audio SDP  http://10.3.37.141/txaudio1.sdp Contrel Media

| Video Glock Status
PTP Grandmaster ID -
PTP Source PortID. -
PTP Domain 0

Status No Clock

| Network status

Medial Media2
IP Address Type Static Addr IP Address Type DHCP

IP Address  172.16.37.141 IP Address
Netmask 255.255.0.0 Netmask

The IPT-10G2-SDI Status screen reports the current status and settings for:
« Stream Status
« Video Clock Status
» Network Status
« NMOS Status
« Firmware Status

Each group of parameters can be expanded or collapsed.

Link Layer Discovery Protocol (LLDP)

Under the Network Status area of the Status Screen, for network switches that
support LLDP, the Chassis ID and the Port ID of the first switch encountered
upstream in the path from the IP Mini-Converter device to the network will be
disp